Welcome

Accession Desktop Communicator is a unified communications softphone client that you can use on your PC or laptop. With Accession Desktop Communicator, all the rich functionality of your office extension can be available to you anywhere, anytime. It is a subscription-based feature that you download directly from your CommPortal “Apps” tab to run on your computer. With this application, you can easily make and receive calls directly from your laptop or from your desktop.

Accession Desktop Communicator is completely integrated with your hosted suite of business services, including Accession Mobile Communicator which can be downloaded to your personal Smart Phone utilizing your cellular data plan to connect to our network. When you use your softphone to answer a call, on any connected device, whether your desk phone, PC, or smart phone, your other devices stop ringing. If you’re on your softphone and another call comes in, it will go straight to voicemail recognizing that you’re already on a call.

Accession Desktop and Mobile soft clients are offered as standard features of FairPoint’s Advantage Plus and Premium Hosted PBX seat packages.

Please Note: The screen shots presented in this document are native to Windows operating system app. The MacOS app is similar in functionality but may look slightly different and action buttons may not appear in the same locations.

This guide is intended to provide users with a broad overview of the application functionality and capabilities. Please note that detailed instructional assistance can be found using the application’s embedded “Help” documentation which can be accessed by clicking on “Help” in the top Tools Bar and then selecting “Help” in the drop down presented, as per below.
Using Accession Desktop Communicator

1) Getting Started

System Requirements

Accession Communicator can be used with
• Windows 7 (Service Pack 1)
• Windows 8 (Desktop UI)
• Windows 10
• Mac OS 10.7 – and above

Your computer should also have the following capabilities.
• Processor: 2GHz processor or higher.
• Memory: 2 GB RAM
• Hard Disk Space: 300 MB
• Outlook Client, Version 10 or above

Equipment Requirements

If you are using Accession Communicator as a softphone, you will also need either a headset, or speakers and a microphone, plus a video camera if you want to make video calls. Choose from the following equipment that will work with your softphone.
• External speakers and microphone
• Built-in speakers and microphone
• Dual-jack multimedia headset
• Bluetooth multimedia headset
• USB multimedia headset
• USB phone
• USB video camera (only needed if you want to send video when making phone calls).

To get started, download Accession Desktop Communicator following instructions included in the Accession Desktop Communicator Installation Guide which can be found at www.fairpoint.com/hostedpbx.

The first time you use Accession Desktop Communicator, the login screen appears. The softphone will always be open and ready to use if you: 1) choose to have the application remember your login information and 2) choose to login automatically each time you boot your computer. If you don’t choose these options, you may open Accession Desktop Communicator manually at any time from your computer’s taskbar.

To open Accession Desktop Communicator:
1. Open your system tray or hidden icons as needed.
2. Click on the Accession Desktop Communicator icon
3. Enter your 10-digit phone number and the password provided by your FairPoint Hosted Support Consultant.

4. If you want Accession Desktop Communicator to remember you, check one or both boxes.

5. Click Login.

When Accession Desktop Communicator opens, you will see a graphical representation of a phone, often called a Graphical User Interface or GUI, as depicted below.

Each one of these highlighted features above are explained in detail in Section 2
2) GUI Main Panel

The **GUI Main Panel** includes the following:

**Presence** – Your presence indicator along with your account name or number appear in this section of the GUI. The colored ICON can provide Business Group members with several states that you may be in throughout the day, including Online, Busy, Do Not Disturb, In a Meeting (based on your Outlook Calendar), On the Phone and Away. This presence will be automatically updated based on your application settings. Should you wish to manually override your presence status just click the down arrow to expose the Presence Menu and select the status you wish to be placed in.

**Tool Bar** – For in-depth documentation of Tool Bar options see Section 4 of this document.

**Photo / Avatar** - Your photo, if you want to upload one, is used as your Instant Messaging avatar. If you do not have an Instant Messaging account, you will not see this picture in the top left corner of the Accession Communicator UI. Just right click on the ICON and browse or take a picture.

**Open Group Chat / Add Contact** – Click to Open a Group chat by selecting multiple members of your Business Group to instant message with or to Add a New Contact to your client.

**Favorite Contacts Tab** – Store frequently contacted persons on this tab by going to the Contacts Tab, right clicking on the contact you wish to mark as a favorite and click “Add to Favorites”. This will place a copy of this contact on your Favorites Tab and will add a gold star, “Favorite’s Indicator” icon to the right of the contact name. To remove simply right click on the contact and select “Remove from Favorites”.

**Contacts Tab** – This tab houses all your imported and added contacts. Your softphone can store the details of your contacts within the Accession UI. It is also provisioned to be linked with one contact source - this will either be your CommPortal, Microsoft Outlook or Mac AddressBook contacts. Depending on your system configuration, you may be able to change this. These contacts appear under the My Contacts tab.

Contacts from CommPortal, Microsoft Outlook or Mac AddressBook that appear in the Accession Communicator UI can be edited in either application, and the changes will be synched between them. If you use Outlook Client 2010 or later, you can click on the sender or recipient of an email in Outlook and make a call or send an IM to this contact using Accession Communicator. You will also see presence information for these contacts in the Outlook UI. For additional information on features surrounding Contacts, please refer to the embedded “Help” documentation.
Recent Calls and Chats Tab - The Recent tab contains history details of all dialed ☎️, received ✆️, and missed calls 🔄️, as well as, all chats, if you have Instant Messaging.

Dial Pad – to manually dial a telephone number or to dial digits once connected to a telephone user interface (TUI) that required digits, post termination, simply Click ✉️ to show or hide the dial pad within the Accession UI

Search Contacts – You can search contacts by typing a contact name or number of the person you want to call or chat with in this field, using either the dial pad or your computer keyboard.

Missed Messages - 📬️ shows if you have any new Voice Mail messages, including the number of messages. Click this to go to the Messages page to view your messages. Any missed calls will also be indicated in a red circle next to the “Recent” tab Highlighted in the red box below. If you click here your recent calls tab will open and the caller information will be displayed.

When you are not using Accession Desktop Communicator, you can minimize the softphone to your task bar or you can close the application. If you close the application, calls will continue to ring other devices, like your desk phone or cell phone, or go to voicemail, depending upon how you have configured your service.

3) Contact Features Menu

By right clicking on any contact, you will expose the features drop down menu. The information included in each individual contact will determine which options are available to you and which options do not apply (Grayed Out items). For example if you do not have an email address saved for a contact the “Send Email” option will be unavailable for this contact. Options include....

Call – Click to call this contact. Should you have more than one number listed, you will be presented a sub menu to select the number you wish to use to call the contact.

Send Chat- Click to establish an instant messaging (IM) chat with fellow Business Group members. Please note, all Business Group contacts imported from Accession or Outlook should be prepopulated the necessary IM address which consists of the users telephonenumber@ams.fpviper.com which is the domain of FairPoint’s IM hosting platform. This IM functionality is internal to your business group associates and is not federated with other external IM service applications.
**Send Email** - Click to establish an email window pre-populated with the contact’s saved email address.

**View Contact** - Click to view currently programmed contact fields.

**Edit Contact** - Click to expose all editable contact information fields. Edit as appropriate and click “Save” at the bottom, to keep your changes.

**Delete Contact** - Hover over this option and select the appropriate delete option.

**Add to Favorites/Remove from Favorites** – Click this option to toggle contacts to and from Favorite’s tab

**Send File** – Click this option to access your computer’s files and select the document that you want to share with that contact, click the “Open” button and the file will be transmitted to the contact via their IM client.

**Review Chat History** - Click on this option and your chats with this contact will be listed by date that they were created. You can select the date you are interested in and review the discussions as well as export if required.

**Notify when Available** – If the contact you want to reach is not presently available, you can click this option and when their presence changes to online or available a pop up will appear informing you of this change in status.

![Contact Status Notification](image)

**Search CRM (Sales Force, Sugar CRM or similar)** – Some Customer Relationship Management (CRM) software applications such as Sales Force and Sugar CRM have a built in functionality that allows Accession to launch a database query to the program based on the caller ID and Name information that is delivered on inbound calls. Please note this integration is a not customizable and whether or not it is supportable is a function of your particular CRM application. There are options for automating these queries or invoking them on a manual basis and we will discuss these options more in Section 4, Tool Bar > Options > Web Apps Tab.
4) Tool Bar

The “File” Menu

The File Menu contains the following options...

![File Menu Screenshot]

**Change Password** - Click on this option to display a pop-up where you can change your password. Enter your old Accession Communicator login password and the new password in the boxes provided, re-enter your new password in the Verify input box, and click Change Password.

**Mute Notification Sounds** - Select to toggle between active and silenced notification sounds.

**Join a Meeting** – This Feature not available presently

**Add Contact** - Click to expose contact input form, Click “Add” button at the bottom when input is complete.

**New Group Chat** – To establish a new group IM session, click this option and then select the contacts you wish to chat with by typing their name in the search bar provided. Note if the contact is not available you will not be able to select them at this time.
Sign Out of Chat – Click on this option to override your current presence status and appear offline; to reestablish connectivity click on Sign into Chat option.

Log Out– This option will completely log you out of the application and will require you to provide your User name and Password credentials to log back in.

Quit– Click this to close the softphone without logging out. This action allows you to reactivate the application without providing your User name and Password credentials.

The Tools Menu

The “Tools” Menu contains the following options...

Options– The Options menu enables you to make changes to the way the softphone behaves, and also to test your audio and video equipment. Additional instructional details can be found in the embedded application “Help” tool under “Setting up the Accession Communicator UI”
We will now review each Option tab...

**General Tab** – The selections below are suggestions to make the application most useful, to most users but can be modified to the functionality preferences of each user.

- **General**
  - Keep in taskbar while the application is running
  - Launch Accession on startup
  - Automatically log in to Accession
  - Use Accession as the default calls and messaging client
  - Use Accession to call phone number links in emails and web pages.

- **Contacts**
  - Double click action in main window: Call contact immediately
  - Use contacts from: Outlook
  - Edits to contacts will appear in both Accession and the contact source.

- **Recordings**
  - Save recordings to: Accession Communicator

- **Analytics**
  - Help to improve the application by sending anonymous usage data

- **Accessibility**
  - Enable Accessibility Mode
  - Your changes will take effect on next restart

- **Reset**
  - Clear User Data

**Analytics** - Tick the checkbox if you want to send anonymous usage data to FairPoint. This can provide us additional data logs for enhanced trouble shooting, if required. Uncheck if you don’t want this data captured.

**Accessibility** - Tick the checkbox if you want to enable accessibility mode, designed to make the Accession Communicator UI more accessible to **blind or visually impaired users**.

**Clear All User Data** - The Clear All User Data button at the bottom of the General screen enables you to delete all your user data from your Accession Communicator softphone.
**Calls Tab** – The selections below are suggestions to make the application most useful to most users but can be modified to the functionality preferences of each user.

**Please make sure** that “Enable Call Park” is selected or you will not be able to Park or retrieve Parked calls via this application.

**Choose a ringtone** - The Accession Ringtone is the default setting but you can select an alternative ringtone by clicking on the “Choose a ringtone” dropdown list and clicking on your preference.

**Turn off Direct Calling** - If you are at your desk and do not want your desk phone and your PC client to both ring you can click on the “Turn off Direct Calling” Button.
Chat Tab – The selections below are suggestions to make the application most useful, to most users but can be modified to the functionality preferences of each user.

Audio Tab – To select or view the audio equipment that you want to use with Accession, click the “Audio” tab. If you are using an external microphone, speakers or headset, you should ensure that these are connected to your computer. Once connected, options to select these devices should appear in the appropriate equipment drop down lists on this tab.
Microphone: You will see a list of available microphone devices. Use the dropdown to select a microphone preference.

To test the device, Click the “Test Mic” button and speak into the microphone selected, that it is connected properly to your PC. As you speak, a recording will be made which can be played back to test for audio quality. If no recording is presented, check that you have not muted the microphone, either on your computer or on a headset if you are using a headset microphone.

Speaker: You will see the speaker that you are currently using. Click the blue arrow on the right hand side to check that the speaker is working. You should hear the default Accession Communicator ring tone.

Ringer: You will see the device that will ring when you receive an incoming call. This will usually be your computer’s speakers. Click the arrow on the right hand side to check that the speaker rings. You should hear the default Accession Communicator ring tone.

Video Tab – Click on this tab to select and test available video sources (built in PC web cams or externally connected devices). Once selected a pop up screen will display the video image of the device which allows the user to set camera angle and lighting to optimize the user experience. Please note you will only be able to establish video chats with business group members equipped with Accession accounts.

Web Apps Tab- Accession has the ability to launch certain URLs to access many commonly used web applications. Please note: Not all interfaces will work and FairPoint support of this feature is limited to instructing the user where to input the values required to activate and test such applications. On this tab you may be able to establish quick access to web based, third party Conferencing (for example Web Ex), File sharing (for example Google Drive) and Customer Relationship Management (CRM) applications (for example Sales Force or Sugar CRM). These options are described in greater detail in “Using the UC Integration Services” section of Accession’s embedded “Help” feature.

As an example, some CRMs have built in capabilities to launch application queries based on caller ID and Name information provided for inbound calls (for this example Sales Force). Please note, this ability to accept these types of web queries is a function of the CRM and not Accession. Once provisioned through your Business Group Administrator’s portal, certain query options will be available, per below.
If you choose an auto-search option, Accession will launch queries based on your selection. This can be particularly useful for customer service representatives that need constant integration to customer account records. If you prefer to launch manually, there are a couple of options to initiate a query:

- When you receive an incoming call, click the **Search in Salesforce** button on the **Incoming Call panel**.
- When you are in a call, click the **Search in Salesforce** button on the **In Call panel**.
• When viewing a contact in your Favorites, My Contacts or Calls lists, right-click on the contact and click the Search in Salesforce button.

• All of these actions will launch your default browser with a Salesforce search for the contact. If there is a single match, you will see the page for that contact page, otherwise you will see a list of results to choose from.

Call Park - If Call Park is provisioned in your Business Group, call park orbits will be set up to be used to place incoming calls in a holding state for pick up at any phone within the business group, without the need to manually transfer the call to a particular extension. Please note, as previously indicated, in order to use call park in Accession you must tick the “Call Park” checkbox located in Tools > Options > Calls > Enable Call Park. The Call Park link opens the Call Park Window where you can view all your available Call Park Orbits.

Once you accept a call a in Accession, the Call Panel will open…to Park a call click on the Call Park activation button, highlighted in the red box below.
This action will open the Call Park window which will show you a list of all park orbits and their status. If an active call has already been parked it will have a green “Pick Up Call” button to the right of the orbit label. All other available orbits will not have an indicator until you hover over the orbit, when a “Park Call Here” button will be revealed. Simply click this button to park the call. To retrieve a parked call either press the appropriate park orbit button on your desk phone or open the Call Park window and click on the appropriate, green park orbit button.

**Conference Manager**- Your FairPoint Accession client can be equipped with an integrated Conference bridge and if so equipped, it can be accessed through the Conference Manager option. Clicking on this option will open the Conference Manager Window. Input your Participant and Moderator codes provided to you by your FairPoint account team and make sure you tick the “Remember Details” checkbox on your first attempt to log in, and click the “Sign In” button. This initial process will save your credentials to allow for one click access to this bridge on subsequent visits as long as you do not sign out of this Conference application or LOG off your Accession desktop app. (See addition information related to exiting this application below)
Once you are signed in you should see the “Open Conference” ICON in the center of the window. When you log in for the first time, or if you have LOGGED Out of your Conference Manager or Accession Desktop Client, since your last visit, first click the small Gear ICON in the top right of the window.

This will bring you to the CommPortal Log in page which allows users to link your CommPortal account contact list which assists in quicker set up of calls to known contacts. Click “Login”

If you have Logged in and associated your Conference Manager with your CommPortal Account, click on the center “Open Conference” ICON to start selecting the contacts you wish to add to your bridge by clicking the green “plus sign” ICON in the upper left of the window.
With your keyboard input the name or telephone number of the contact you wish to invite to the conference (if you have associated your CommPortal application as previously discussed). If you want to dial a number of someone who is not in your contact list, simply enter the telephone number of the person you want to add. Click “Add”

Once you have added all the conference attendees (MAX of 12 including yourself) click “Join” and then “Connect” (if you want to join from a number different that you Accession client please type it in the field provided before clicking “Connect”
If you would like to access the conference web GUI, click the ICON in the upper most right of the window.
The Conference Graphical User Interface (GUI) will be presented. From here you can Lock your bridge, start and stop recording, mute and drop attendees, etc. from the conference GUI.

DO NOT click the “Log Off” button here when you are done with the call but rather return to your Conference Manager window and click on the “End” button in the lower right corner of the window and then confirm this action by Clicking on “End” located in the center pop up window.
Next click on the red X at the top right of that window. This will keep your sign in credentials in tact so you can access the application again at a later date without having to re-enter User and password information.

Apps- Click on the Apps option and Accession will take you directly to your CommPortal Dashboard, Apps tab where you can obtain links to download applications available for your individual account, like Accession Desktop and Mobile clients.
**View Account** - Click on the View Account option and Accession will take you directly to a portal where you can, change your e911 address record, as well as, make changes to your phone programming. PLEASE NOTE: to Change your **Password or PIN** you will need to log in directly to your CommPortal Dashboard account and access the “Settings” tab.

![View Account](image)

**The “Help” Menu**

The “HELP” Menu contains the following options...

![Help Menu](image)

**Check for Updates** – Click here to see if there is a later software version of Accession available for download.

**Help** - Additional, detailed application instructional assistance can be found using the applications embedded “Help” documentation which can be accessed by clicking on “Help” in the top Tools Bar and then selecting “Help” in the drop down presented.

**Send Feedback** – This feedback section provides users a place to make enhancement suggestions to the Software developers and owners of Accession. There is no commitment by them to initiate any functionality, but this link allows a vehicle for consideration. **Please do not**
use this link to report software bugs, user functionality issues or any other service troubles. These issues should be reported directly and triaged by FairPoint resources. Please see Section 8 for Help and Troubleshooting processes.

**About** – Clicking the “About” option will tell the user which version of Accession is currently running on you device.

![Accession Communicator](image)

---

5) **Making Calls**

When making or receiving calls from your computer, you can choose to use your PC’s speakers and microphone or use one of the other devices described in Section 1 of this guide. Calls made and received using Accession Desktop Communicator are transmitted over the data connection to your PC rather than through your desk phone, however your desk phone and any Accession equipped device (PC, Smart Phone or Tablet) are all tied to the same account allowing seamless, almost ubiquitous service anywhere you have internet access.

**Please note:** The number entered must follow the dialing plan for your business group (e.g. 9-555-2345) or be a 10-digit number. Storing your contact phone numbers using the full 10-digit number will allow you to get the most out of these dialing options.

**Making an audio call...**

**Manually entering a name or number to make a call**

You can make a call by manually entering a name or number on the softphone UI:

1. Click \( \text{\text{\text{\texttt{ }}}\text{\text{\text{\texttt{ }}}}} \) to show or hide the dial pad on the softphone.
2. Enter a number or the name of a Contact in the input field, using the dial pad or your computer keyboard.
3. As you type, Accession will display entries from your contacts and calls tabs and, if you have one, a company directory, that match what you are typing. You can then select an entry from the list of results for quicker dialing.

4. To start the call, either press Enter on your keyboard, or use the green Call button on the softphone.

5. You will hear a ringing tone, and a Call Panel (See Section 7 “When you’re in a Call”) will open on your computer, showing details of the person you are calling and the progress of the call.

6. To clear a name or number from the input box, click .

Calling a contact
You can make a call to an entry on the Favorites or My Contacts tabs without having to type in their number. How you do this depends on how many phone numbers you have configured for the contact, and what type of call you want to make.

1. Open the Favorites or My Contacts tab.
2. Find the Contact that you want to call. If you have a very long list, use the input box to type in their name. Accession will display the possible matches as you type.
3. You now have a number of options for calling the contact.
   o If you want to make an audio call to their primary phone number, double-click on the contact’s name.
   o If you want to be able to choose the number that you call the contact on, select the contact. Click the icon to see a list of available numbers and click the one you want to use.
   o Right-click on the contact to choose further call options. Select Call, for an audio call, (you can add video to an audio call once it has been connected if both parties are equipped to do so). If you have more than one number for a Contact, select the number that you want to use for this call.

You can also make calls to people who appear on the Recent tab. This is done in almost the same way as calling a contact on the Favorites or My Contacts tab. However, you should note the following differences.

- Double-clicking on the entry or using the button will always call back the number that the person used to call you.
- Right-clicking on the entry will show all the possible phone numbers that you can use to return the call.

Making a video call
If you have video calling enabled and have a camera on your computer, you can use your softphone to make a video phone call.

To uplift an established audio call to video, use the button on the In Call panel. The person you are calling may or may not choose or be able to send you their video. If they are another Accession Communicator subscriber with video calling enabled, they will be able to start streaming video immediately.
6) Receiving Calls

To receive a call on your computer or Smart phone, your softphone client must be open on your device. Incoming calls are signaled by a ringing tone and by a call alert Incoming Call Pop Up Box on your screen. You can answer the call by clicking on the yellow “Accept” box. You can also “Reject” the call by clicking the red box which will send the call to voicemail.

Incoming Call Pop Up Box

If the call is from one of your Instant Messaging contacts, you can choose to click the down arrow to reject the call but send the caller an IM message explaining why you cannot take their call. You can either select one of the system messages or press Custom message and type your own message.

Reject with message:
- “Can’t talk now. Call me later?”
- “Can’t talk now. What’s up?”
- “I’ll call you back”
- Custom Message...

If you use a Customer Relationship Management (CRM) service, you can click the search button to launch the service and view the information you have for this caller. See Using the UC Integration Options for more information on using this service.

Receiving a second call

Your account may be configured to allow you to receive multiple calls simultaneously on Accession Communicator.
If you are already on a connected call and receive a second incoming call, you will hear a Call Waiting beep through your speakers or headset. You will also see an Incoming Call Popup on the screen.
You can answer or decline this call in the same way as any other incoming call. If you choose to answer the second call, the first call will automatically be put on hold and you will be presented with a second In Call window. If you receive two incoming calls at the same time, you will see two Incoming Call Popups on screen. You can answer or decline each call individually. If you choose to answer both, you will see the behavior described above.

Missed Calls
You can view details of received and missed calls on the Recent tab.
- If you are not currently viewing the Recent tab and you fail to answer a call, you will see a red circle with a white number indicating the number of calls you have missed since you last opened this tab.
- If you have the Recent tab open, a missed call will simply appear at the top of the list of calls and/or chats.

Access Voicemail and Messages
Your softphone uses 📞 new to indicate when you have a new voicemail message, as a result of a missed call. Clicking the icon takes you to your CommPortal “Messages” tab where you can access your messages.

7) When in a Call
Once you are in a call that you have either made or received, you will see the In Call Panel.

Feature Options Available in the Call Panel
Click this ICON, located to the left of the center Avatar, to add another caller to the conversation (3 way calling)

Click this ICON to initiate a call transfer.

Click this ICON to initiate a Chat session (if IM is an available option for the contact)

Click this ICON to initiate a manual CRM query (if so provisioned)

Click this ICON to place the call on Hold, click again to resume call.

Click this ICON to initiate uplift to Video Call (if both parties so equipped)

Click to toggle MIC Mute functionality or to adjust volume

Click to toggle Speaker Mute functionality or to adjust volume

Click to expose Dial Pad to key in any additional numbers while in a call

Click the “Switch” ICON to enable Call Jump. This function enables the user to “Jump” the call to another twinned device or Accession application such as your desk phone, smart phone or tablet (equipped with Accession Mobile client).

Using Call Jump

Pushing a call
When a subscriber is in a single, 2-way call on Accession Desktop, the In-call panel will display the call push icon.
Call Push option on Accession Desktop
When the subscriber clicks on the call push icon, all their other Accession clients and twinned devices will ring, and the In-call panel will indicate that a call is in the process of being switched to another device.

As soon as the subscriber picks up the call on one of their other devices, for example Accession Mobile or a twinned desk phone, the call ends on Accession Desktop. If the subscriber does not pick up, or rejects the call on another device, the call continues on Accession Desktop.

Pulling a call
The Accession Desktop UI will display a call pull button at the bottom of the screen whenever a subscriber has a call available to pull on to Accession Desktop.
Call Pull option on Accession Desktop
When a subscriber clicks on this button, they will see a dialog box giving them more information about the call that is available. If the call is from a contact, the contact name is displayed; otherwise the caller's number is shown.

Click below to pull the call to this device.

The subscriber can then either click **Pull Call** to continue the call on Accession Desktop, or press **Cancel** to keep the call on the original device.

Click to toggle local PC call recording. These files will be stored in the folder selected on the Tools > Options > General > Recordings section of the application. **USERS ARE WHOLELY RESPONSIBLE FOR FOLLOWING ALL FEDERAL AND LOCAL JURISDICTIONAL LAWS PERTAINING TO CALL RECORDINGS.**

Click this ICON to park this call (if Call Park is provisioned for your Business group and activated on the Tools > Options > Calls tab.

Click this ICON to end the call

8) Help and Troubleshooting

When you have questions about how features work or are having trouble with your softphone, always check the embedded Help documentation found on the top Tool Bar menu.

For additional technical assistance or trouble reporting please contact your assigned Business Group Administrator to attempt local resolution.

Lastly, if your Administrator is unable to resolve, please call 855-588-9300 or email your trouble to managedservices@fairpoint.com and FairPoint’s Advanced Service Team (AST) will assist you in resolving any service related issue.